
Distributed Deconvolution User Guide

I. Introduction

Force generation in striated muscle arises from the relative sliding of the thin and thick filaments within 
sarcomeres.  While thick filaments are constant in length across muscles and species, thin filament 
lengths in striated muscles are muscle-specific and surprisingly variable, from as low as ~0.95 μm in frog 
leg muscles to as high as ~1.40 μm in human shoulder muscles.  The ability to measure thin filament 
lengths is essential in a variety of contexts in muscle biology, such as studying how gene perturbations, 
disease states, and/or altered use patterns affect sarcomere structure.  To this end, the Fowler laboratory
at The Scripps Research Institute has developed procedures for processing muscle tissue for 
immunofluorescence confocal imaging and application of distributed deconvolution (DDecon) analysis to
measure positions of thin filament components using fluorescence images.  For example, the distance of 
tropomodulin (Tmod) from the Z-line provides thin filament length, as does half of the breadth of a 
phalloidin-stained thin filament array (see below). The position of the N-terminal M1M2M3 domain of 
nebulin (Neb-N) provides the length of the nebulin-stabilized core of the thin filament, which is relatively
constant from muscle to muscle (~0.95 μm).  These and related measurements allow a detailed 
quantitative characterization of thin filament architecture without the need for time-consuming electron
microscopy approaches.

The sarcomere – defined as the region
between two successive Z-lines in a
striated myofibril – is the fundamental
functional unit of striated muscle
contraction.  By contrast, the critical
unit of thin filament length
measurement is the thin filament
array – defined as one Z-line plus its
attached thin filaments that extend
into the neighboring half-sarcomeres
on either side of that Z-line (Figure 1). 
The barbed ends of the thin filaments
are anchored in the Z-line, while the
pointed ends normally flank the M-
line in the center of the sarcomere,
demarcating the periphery of the H-
zone (Figure 1).  A critical observation
regarding the organization of striated
myofibrils is that sarcomere lengths vary with the degree of thin and thick filament overlap, but thin 
filament lengths remain constant regardless of the degree of overlap.  Consequently, in order to measure
thin filament lengths using DDecon, sarcomeres must be adequately stretched such that neighboring 
thin filament arrays do not overlap.  If sarcomere lengths are too short and thin filament arrays overlap, 
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Figure 1. Thin filament organization in striated myofibrils (from
Littlefield & Fowler, Biophys J 2002). Schematic diagram of 
three sarcomeres and the symmetric thin filament arrays shared
between them. Z, Z lines; M, M lines; H, H zones; P, thin filament
pointed ends; B, thin filament barbed ends. The structure of thin
filament arrays remains the same in long (left) and short 
(middle, right) sarcomeres.



it becomes exceedingly difficult to distinguish where one thin filament array ends and the next begins, as
Tmod staining is typically unresolvable into discernable doublets, and phalloidin staining for F-actin is 
continuous.  In the case of relaxed but unstretched sarcomeres, where small gaps may be evident 
between adjacent phalloidin-stained thin filament arrays, the Tmod doublets are still unresolvable.  In 
this instance, thin filament lengths measured based on the phalloidin staining may also be unreliable due
to inaccurate background subtraction.  Sarcomere stretching must be achieved during tissue preparation 
for fluorescence microscopy prior to DDecon, although the methods will vary depending on the nature 
of the muscle specimen (cultured myocytes, intact mouse muscles, human biopsies, etc.) and the tissue 
processing procedure.

DDecon exploits the periodic and stereotypic organization of striated myofibrils to perform thin filament 
length measurements. DDecon is a super-resolution computational averaging technique that computes 
thin filament lengths and positions of thin filament components with a precision of 10–20 nm by directly 
determining the peak positions of fluorescently labeled thin filament proteins with respect to the Z-line 
using line-scans of fluorescence intensities along myofibrils.  Using line scan data, the DDecon algorithm 
generates the best fit of a model intensity distribution function for a given thin filament component to 
an experimental one-dimensional myofibril fluorescence intensity profile.  Model fitting is optimized by 
an iterative fitting procedure that minimizes error between observed and modeled intensities using a 
multivariate line-fitting algorithm.  This manual details protocols for installing DDecon, managing 
fluorescence image sets, selecting and background-correcting line scans, and performing DDecon-based 
fitting.  DDecon is currently available as a plugin for ImageJ, an open-source image analysis program.  The
most current version of DDecon is available for public download at http://www.scripps.edu/fowler/.

II. Installing the Distributed Deconvolution (“DDecon“) ImageJ plugin

Prerequisites
DDecon operates the free open-source program ImageJ, version 1.43o or higher.  We recommend that 
you use the ImageJ menu option "Help > Update ImageJ..." to download the latest version, which is not 
always directly available on their website.   We recommend that ImageJ be configured for optimal 
performance in your system; both the available memory and CPUs can be set in the ImageJ menu "Edit > 
Options > Memory & Threads...". 

Installation
Simply copy the DDecon_.jar file and the underlying database derby.jar file to the plugins folder under 
the ImageJ installation directory, and restart ImageJ.

Starting/exiting the program
Starting the program
Once you launch ImageJ, you will find the DDecon menu options under "Plugins > DDecon".  Clicking on 
"LSDDecon Launch" brings up the first main window.

Exiting the program
You can do either of the following to exit the program:
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• Click the [File] menu, and click [Exit].
• Click the close button [X] in the upper-right corner of the window.

III. Working with entities in the DDecon program

“Experiment”, “Image”, and “Line Scan” are the entities in the DDecon program.  There is a one-to-many 
relationship between any two entities (i.e., one experiment may include one or more images, and one 
image can have one or more line scans).  When you start ImageJ, you will find the DDecon menu options 
under "Plugins > DDecon".  Selecting the “LSDDecon Launch” submenu launches the main window 
(Figure 2). This interface is arranged like horizontal writing (moving from top to bottom and from left to 
right) in order to effectively manage these entities.

Figure 2. Parts and controls of the main window.
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A. Experiment panel:
This section (Figure 3) is used to manage your experiments.  You can select an existing experiment from 
the dropdown list or add a new experiment by clicking the “Add Experiment” button; if a selected 
experiment is no longer needed, you may delete it.

1.

Add Experiment: Clicking this button opens an input box (Figure 4).  Enter the name of the experiment,
followed by pressing either the “OK” button or “Cancel” buttons.
2. Delete Experiment: Clicking this button brings up a dialog box (Figure 5) for you to confirm deletion 
of the experiment.  Pressing the “No” button cancels deletion.  Even if the “Yes” button is pressed, a 
second warning and a final warning will be given (Figure 6).  Acknowledge the deletion by pressing the 
“Yes” button.  Otherwise, no deletion will occur.

B. Sample & Stain panel:
This section (Figure 7) is used to enter the sample information and stain type.  Enter any description for 
the sample and the fluorescence label used for the sample.  The stain type is required, and the default 
stain type is phalloidin.  You need to select a correct stain type for the image you are going to load.  
Available stain types in the current version are Z-line, P-end, phalloidin and early labeled actin.

C. Image panel:
This is a list of existing images associated with the experiment
(Figure 8).  You may select an image from the list or load a new
image to add to the experiment by clicking the “Load New Image” button, navigating to the image file 
location, and selecting the image file.  The loaded image is then displayed in a new window (Figure 9).  
As the button names suggest, you may delete a selected image or clear the entire image list from the 
experiment.
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Figure 3. The Experiment panel. Figure 4. An input box for entering an experiment 
name.

Figure 5. The first warning before deletion. Figure 6. The second warning before deletion.

Figure 7. The Sample & Stain panel

Figure 8. The Image panel.

Figure 9. An active image.



D. Line Scan panel:
This panel (Figure 10) displays a list of line scans associated with the active image.  Line scans are 
determined for segments of myofibrils that are well-preserved, contain three or more thin filament 
arrays, and display striations that run perpendicular to the long axis of the myofibril.  You may select a 
line scan from the list or draw a new line scan by dragging and releasing the mouse, then clicking the 
“Add Line Scan” button after drawing a line segment on the active image.  Either way, the highlighted line
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Figure 10. The Line Scan panel.



segment on the image corresponds to the line scan name that you select from the list or the line scan 
that you want to add to the list.  As the button names suggest, you may delete a selected line scan from 
the image.

E. Line Scan Analysis button: Clicking this button (Figure 11) brings up next window (Figure 12) for line 
scan analysis. 

IV. Analyzing a line scan

This interface (Figure 12) allows you to manipulate the line scan that you selected in the previous image 
window by fine-tuning the settings of the line scan.

A. Line scan sub-image: This panel shows the line scan subimage with dimensions (total length and total 
width in pixels) as defined in the “Line Scan Information” panel (Figure 12, D).  For example, in the 
screenshot shown, the line scan’s length and width are 296 pixels and 40 pixels, respectively.  The middle
section marked with a red rectangle is referred as the RawLS area, which is the myofibril region, while 
the sections immediately above or below the myofibril region, called the Background 1 area and the 
Background 2 area, respectively, have to be suitable for background subtraction or background 
correction (Figure 12, G). Sometimes, the Background 1 (BG1) and/or the Background 2 (BG2) areas are 
marked with a yellow rectangle (Figure 12, G).   Important: BG1 and BG2 are only intended to be used 
for isolated myofibril preparations.
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Figure 11. The Line Scan Analysis button.



Figure 12. Parts and controls of the line scan window.
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B. Raw pixel intensity plot: This plot displays the pixel intensity (y-axis) at each pixel position (x-axis), as 
determined with the option (maximum, median, average, or minimum) selected in the Line Scan Profile 
panel (Figure 12, G).  For example, in the screenshot shown, the average intensity of the RawLS area with
a width of 20 pixels is plotted at each pixel position. 

C. Corrected pixel intensity plot: Using the selected background correction mode set in the “Line Scan 
Profile” panel (Figure 12, G), this plot shows the corrected pixel intensity (y-axis) at each pixel position (x-
axis) after background intensity subtraction from the raw pixel intensity plot (Figure 12, B).

D. Line Scan Information panel:
This section (Figure 13) displays the length and the width (in pixels) of the line
scan, the angle of the line scan, and the start and end coordinates of the line
scan on the image.
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When a line scan is selected, the following considerations must be heeded: (1)
a line scan is drawn by dragging and releasing the mouse. The first point that
you click is treated as the start point. When the mouse is released, the second
point is treated as the end point. Therefore, the line scan is a vector with the

direction from the start point to the end point. (2) The image window coordinates begin in the upper-left
corner of the window, with the x-coordinate increasing as you move to the right and the y-coordinate 
increasing as you move down (Figure 14).  The angle of the line scan is theta (θ) from the conversion of 
Cartesian coordinates (x, y) to polar coordinates (r, θ) (Figure 15).  Therefore, the angle of the line scan is 
defined as the angle between the x-axis and the line scan vector (i.e., the angle formed by rotating the x-
axis to the line scan). The angle is expressed in degrees from −180° to 180°. In the coordinate system of 
the image window, clockwise (CW) rotation generates a positive angle (Figure 16), while 
counterclockwise (CCW) rotation generates a negative angle (Figure 17).  (3) When selecting a line scan, 
it is essential that a line scan be drawn from one M-line to another M-line within a myofibril. This will 
ensure that the line scan captures entire intact thin filament arrays and not fractions of thin filament 
arrays.
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Figure 13. The Line 
Scan Information 
panel.

Figure 14. The image window 
coordinate system.

Figure 15. The conversion of Cartesian 
coordinates to polar coordinates.

Figure 16. Clockwise (CW) rotation 
generates a positive angle.

Figure 17. Counterclockwise (CCW) 
rotation generates a negative angle.



E. Line Scan Settings panel:
This section (Figure 18) enables you to define a number of settings for the line scan.

1. The width of each section (RawLS, BG1, BG2) of the line scan can be set separately by entering a 
number of pixels and pressing ENTER.  The subimage will change accordingly.
2. “Point 1” is the first point on the image that you click to start drawing a line
scan, while “Point 2” is the second point on the image that is logged when you
finish drawing a line

scan by releasing the mouse.  When a 
checkbox is unchecked, the point is 
fixed (i.e., you cannot move that point).  If both checkboxes are unchecked, there will be no effect.  By 
default, both points are checked.
3. “Reference Frame” includes two options – “original” and “subregion”.  The original reference frame 
is the frame of the current image in the window.  When displaying a line scan, the selected line scan is 
first oriented horizontally by computationally rotating the image.  The subregion reference frame is the
frame of the rotated image.

4. “Skew” is the degree of rotation away from the original line scan selection. Clockwise (CW) rotation 
generates a positive rotation, while counterclockwise (CCW) rotation a negative rotation. The step is 
5°, or you enter the number of degrees manually, followed by pressing ENTER.

5. “Major Step” and “Minor Step” define the number of pixels that you can move each time you click 
any navigation button (up, down, left, and right).  By default, the major step is 1 pixel, and the minor 
step is 0.1 pixel.  You can change both of these step sizes.  Nothing prevents you from entering a larger 
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Original reference frame

Subregion reference frameOriginal image

Figure 18.  The Line 
Scan Settings panel.

Figure 19. Reference frames.



number in the Minor Step box than in the Major Step box.  The major step is used when you move the 
line scan.  To use the minor step, press the SHIFT button when you use any navigation button.

F. Line Scan Adjustment panel:
The buttons in this section (Figure 20) allow you to move or rotate the line scan
on the image as the thumbnail on the button suggests.

G. Line Scan Profile panel: The description of the line scan subimage (Figure
12, A) explains the three sections – RawLS, BG1 and BG2 – in the line scan
subimage.  The myofibril region of interest in the red rectangle (i.e., the middle
RawLS section) is typically 20 pixels wide (Figure 12, A) and chosen along the
selected myofibril with the intensity determined by the checked option
(maximum, median, average, or minimum) (Figure 21).

There are 6 background correction modes.  Depending on which model is
selected, none or only one or both of the flanking background sections are used
for background correction, which means that the background intensity is
subtracted from the intensity of the RawLS section at the same pixel location.
Two modes (RawLS – Auto and RawLS – [constant]) use none, two modes
(RawLS – Min(BG1,BG2) and RawLS – Ave(BG1,BG2)) use both, and two modes
(RawLS – BG1 and RawLS – BG2) use only one of the two background sections.
Accordingly, the background sections being used are highlighted by a yellow rectangle in the line scan 
subimage (Figure 12, A).  The default background correction mode is RawLS – Auto.

H. Do DDecon button: Once you finish adjusting the scan line of interest, you are
ready to perform distributed deconvolution analysis on the line scan by clicking
the “Do DDecon” button (Figure 22).

V. Distributed deconvolution analysis

Distributed deconvolution analysis models a line scan as a combination of three independent fluorescent
intensity distribution functions: the “Gaussian distribution” function, the “Z-line distribution” function, 
and the “thin filament distribution” function.  Briefly, the Gaussian distribution accounts for the spread 
of light at various focal positions, whereas the Z-line distribution accounts for sarcomere lengths and 
myofibril thickness.  The thin filament distribution accounts for the location of thin filament components 
(e.g., phalloidin, P-end, and Z-line) within a thin filament array and is thus particularly important for 
determining thin filament lengths. Convolution of the thin filament and the Gaussian distribution 
functions generates the thin filament profile, whereas convolution of the thin filament profile with the Z-
line distribution function generates the myofibril profile. The thin filament profile and the myofibril 
profile correspond to a line scan of a single thin filament array and of a myofibril (i.e., a series of thin 
filament arrays), respectively.  The theory of distributed deconvolution is described in Littlefield & 
Fowler, Biophys J 2002.
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Figure 20. The Line Scan 
Adjustment panel.

Figure 21. The Line
Scan Profile panel.

Figure 22. The Do 
DDecon button.



This interface (Figure 24) enables you to perform distributed deconvolution analysis. The results are 
outputted after line scan analysis (which you adjusted in the previous line scan window) by either 
manually or automatically setting various parameters for the model of interest.

A. Model profile plot: This is the model profile plot based on the selected stain type with the current 
model profile parameters set in the model “Profile Parameters” panel (Figure 24, F).

B. Model residual plot: This is the combined residual plot of the entire observed line scan intensity 
shown on the repeat residual plot (Figure 24, D) at each data point.

C. Repeat profile plot: This is the distributed deconvolution profile plot of the line scan before or after 
the model profile is applied to fit the line scan.  When hovering over hot spots around red crosses, the 
mouse cursor changes into a hand.  At this time, you can change the model profile (the blue line) by 
dragging the cross in order to optimally overlap with the observed line scan (the black line) by visual 
inspection.  This plot for the early labeled actin model is somewhat different from that for other models 
(see model details in Section VI Working with various stain types).

D. Repeat residual plot: This is the distributed deconvolution residual plot of the observed line scan 
intensity subtracted by the modeled line scan intensity at each data point before or after the model 
profile is applied to fit the line scan.

E. Line Scan Information panel:
This section (Figure 23) presents information related to
the line scan, including the file location, the file name of
the image associated with the line scan, the line scan
name, date, sample, and fluorescence label entered in
the main window, the experiment time, and stain type.
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Figure 23. The Line Scan Information panel.



Figure 24. Parts and controls of the distributed deconvolution window.
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F. Model Profile Parameters panel:
The details of each profile parameter (Figure 25) are a follows:

1. Focus: The Focus output reflects the sharpness of the thin filament distribution.
The lower the focus, the sharper the distribution.
2. Length: The Length output reflects the length of thin filaments.
3. Uniform: This Uniform output reflects the uniform fluorescence intensity along the
thin filament array.
4. P-end:  The P-end output reflects the intensity at the pointed ends.  For instance,
in the P-end model, this is the intensity of peaks at the pointed ends; however, in the
phalloidin model, the P-end intensity is 0.

If the checkbox next to each of the above parameters is checked, that parameter is
locked to the value being displayed.

G. Z-line Positions & Intensity Adjustment panel:
This section (Figure 26) works with Z-lines.  The
number of Z-lines is shown.  You can manually
enter a Z-line number by pressing ENTER.  The
number of Z lines included in the model is
determined from visual inspection of the
myofibril image and includes any Z line within
~5 pixels from either end of the line scan.  The
Z-line positions determine where the Z-lines
are located along the myofibril line scan, and
the Z-line weights determine the overall
intensities of the Z lines.  For each Z-line, its position and intensity are listed in one column in the text 
box.  You can modify these by pressing the ENTER button and observing that the blue line in the “Repeat 
Profile” plot changes accordingly.  There is a checkbox below the “Pixel Position” textbox and a checkbox 
below the “Pixel Intensity” textbox in each Z-line column.  If a checkbox is checked, the value of the 
textbox above cannot be changed.  If ”Fix All Z-line Positions” is checked, all individual checkboxes for Z-
line positions are checked as well; if any of the individual checkboxes for Z-line positions is unchecked, 
”Fix All Z-line Positions” is unchecked.  ”Fix All Intensity” functions in the same manner.

H. Results Summary panel:
This section (Figure 27) presents the analysis results.

1. Area: This is the percent area of the observed line scan intensities
accounted for by the modeled intensities.
2. Correlation coefficient: This is the correlation coefficient of the observed
line scan intensities and the modeled intensities.
3. R2: This is the coefficient of determination, which equals the square of
the correlation coefficient between the observed and modeled data values
and provides a measure of how well future outcomes are likely to be
predicted by the model.
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Figure 25. The 
model Profile 
Parameters 
panel.

Figure 26. The Z-line Positions & Intensity Adjustment
panel.

Figure 27. The Results 
Summary panel.
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Figure 28. The button panel.

4. (P1+P2) / Z Ratio: This is the comparison of the relative areas under the pointed-end and the
barbed-end peaks in living and fixed cells, indicating the fluorescence intensity at the pointed ends 
with respect to the barbed ends, for the Early Labeled Action model only.  It displays N/A for all other 
models.
5. Error: This is the difference between the observed line scan intensities and the modeled intensities, 
which is essentially the sum of the square of the residuals scaled to the maximum intensity in the line 
scan and the number of data points.  If the error after fitting is less than 6%, it is shown in green; if the 
error is between 6% and 10%, it is displayed in orange; otherwise, it is displayed in red.

I. Button panel (Figure 28):
1. Smart Initializer: This performs an initial estimate of the
model profile parameter values.  After pressing the button, you
can observe changes in the model “Profile Parameters” panel
(Figure 24, F) and the blue line in the “Repeat Profile” plot
(Figure 24, C).

2. Fit Profile: A dialog box (“DDecon Fitting Options”) (Figure 29) opens when this button is pressed.  
These are options for advanced users.  For general end users, there is no need to change these 
options.  The simplex method is a method for solving problems in linear programming, which is 
optimization of an outcome based on a set of constraints using a linear mathematical model.  
Distributed Deconvolution is one such linear mathematical model, a combination of the “Gaussian 
distribution”, “Z-line distribution”, and “thin filament distribution” functions.   If you wish to change 
these options, check the “Advanced user options” checkbox, enabling all text boxes and the details for 
these options, which are as follows:

 Maximum iterations: Maximum number of
iterations per Simplex restart;

 Number of restarts: Number of Simplex restarts
initially set to be performed;

 Position search distance: Maximum change of
each Z-line position during fitting;

 Intensity search percentage: Maximum
fractional change in Z-line weight during fitting
(expressed as a percentage);

 Minimum thin filament length;
 Maximum thin filament length;
 Error Tolerance [1×10-x]: Maximum error

tolerance;
 “Weight by distance from repeat center”

checkbox: Experiment for non-uniform fitting;
 “Best Fit” checkbox: If the Best Fit checkbox is

checked, the fitting algorithm will be run
continuously until the optimal fit is achieved.
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Figure 29. The DDecon Fitting Options dialog box.



After clicking OK, the DDecon analysis algorithm will refine the parameters through a fitting algorithm 
that minimizes the error between the observed line scan intensities and the modeled intensities.  After
a solution is determined for a myofibril line scan, the parameters for the solution are stored in an 
underlying database for statistical analysis.

3. View LS Summary: This command button outputs the line scan results into a .csv file, including date 
& time, profile, image file name, experiment, model profile parameters used (focus, length, uniform, 
and P-end), number of Z-lines, line scan results (area, correlation coefficient, R2, error), the average of 
Z-line-to-Z-line distance, and each individual Z-line to Z-line distance between two adjacent Z-lines.  
Sarcomere length is equivalent to Z-line-to-Z-line distance.

VI. Working with various stain types
There are three available stain types in the current version of DDecon.  Select line scans from M-line to 
M-line for all stain types.
 Z-line model (Figure 30): This model is based on the specific localization of α-actinin in the Z-lines of 

myofibrils.

Figure 30. The Z-line model.

 P-end model (Figure 31): This model is based on the localization of Tmod at the thin filament pointed
ends in striated muscle.  The Tmod distribution function consists of two peaks on both sides of the Z 
line and a low uniform fluorescence between the peaks.

Figure 31. The P-end model.
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 Phalloidin model (Figure 32): This model is based on the presence of actin along the thin filaments, 
the overlap of thin filaments at the Z line, and the ability of phalloidin to bind uniformly along 
filaments in a 1:1 ratio with actin subunits.

Figure 32. The phalloidin model.

 Early labeled actin model (Figure 33): This model is used in research on actin dynamics at pointed 
ends that regulates thin filament length by microinjecting muscle cells with rhodamine-labelled actin
(rho-actin).

Figure 33. The early labeled actin model.

The distributed deconvolution profile plot for the early labeled actin model is different from that for 
other models (Figure 34).  One measurement is (P1+P2) / Z ratio, which is the average of the relative 
areas under the pointed-end and the barbed-end peaks for all repeats.  Each unit repeat has two 
pointed-end peaks and one barbed-end peak.  One unit’s right pointed-end peak overlaps with the 
next unit’s left pointed-end peak.  In order to calculate the ratio, such two overlapped peaks must be 
separated.  Like all other models, the model profile is displayed in blue while the observed line scan in 
black.  Unlike all other models, the model profile is displayed in thick blue line and the separated 
model profile for each unit is displayed in a thin line with the first in red, the second in orange, the 
third in yellow and the fourth in green, and so on in this color pattern.  It is clear to tell that at each 
position, the intensity of the thick blue line is the sum of the intensity of the two separated thin lines.
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Figure 34. The early labeled actin model.

VII. Reference:
Littlefield, R., and V. M. Fowler. 2002. Measurement of thin filament lengths by distributed deconvolution
analysis of fluorescence images. Biophys. J. 82:2548–2564.
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